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Preface

Welcome to the Opsware Operational Management Database (OMDB), the first
configuration management database (CMDB) that offers seamless change automation.
Leveraging the Opsware System consisting of the Opsware Server Automation System
(SAS), Opsware Network Automation System (NAS), and the Opsware Application Storage
Automation System (ASAS), the OMDB automatically populates and maintains all the
infrastructure configuration items (Cls), their detailed attributes, and interdependencies.
After the OMDB is populated with the data, customers can easily execute changes to
configure and remediate the IT infrastructure.

Overview of this Guide

This guide describes how to use Opsware OMDB, starting with an introduction to the
system and how to navigate the user interface. It provides information about Search,
Reports, Dashboard, and Custom Reports.

Contents of this Guide

This guide contains the following chapters and appendices:

Chapter 1: OMDB Overview: Provides an overview of Opsware OMDB, the OMDB user
interface, the OMDB Client, and the Search feature.

Chapter 2: OMDB Reports: Provides an overview of the OMDB Reports feature, and how
to run, print, export and schedule reports.

Chapter 3: OMDB Dashboard: Provides an Overview of the OMDB Dashboard and how
to set the Dashboard options.

Chapter 4: Creating Custom Reports: Provides instructions for saving a search as a
report, using BIRT RCP Designer to design custom reports, and adding custom reports to
OMDB.
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Chapter 1: Introduction to the OMDB Client

This section discusses the following topics:
+ Overview of OMDB

+ OMDB Client and OMDB Client Launcher
+ OMDB Client

+ Key Terms and Concepts

+ Search

+ Quick Search

+ Advanced Search

* ltem Browser

Overview of OMDB

The Opsware Operational Management Database (OMDB) is a configuration
management database designed to create and maintain a record of the infrastructure
data in your IT environment. It has the ability to store information from Opsware SAS,
Opsware NAS, and other third party systems. You can use the OMDB Search, Reports,
and Dashboard features to view and analyze IT infrastructure such as applications,
servers, networks, and storage.

The OMDB feature enables you to perform the following tasks:

« Search and browse for configuration items in your IT environment.

+ Create reports and view report results on infrastructure data in your IT environment.
« Run existing reports and schedule reports.

« Aggregate report results to your dashboard.

Create custom reports.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved. 9
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» Perform historical reporting and compare the results with the current report results.
« Perform actions on search and report results.

« Define security boundaries around the configuration items. You can constrain OMDB
feature access based on user permissions.

The OMDB Client provides the following features:

+ Search: Enables you to search and browse for configuration items in your IT
Environment. See “Search” on page 19 for more information.

* Reports: Enables you create reports, view report results, run existing reports, and
schedule reports. See “OMDB Reports” on page 35 for more information.

- Dashboard: Enables you to aggregate report results to the dashboard. See “Overview
of Dashboard” on page 57 for more information.

+ Opsware Administration: Enables you to set the options for Scheduled Reports and
Dashboard. See “Setting Dashboard Options” on page 60 for more information.

OMDB Client and OMDB Client Launcher

The OMDB Client Launcher is a self contained Java application that allows you to access
the OMDB Client from any OMDB core. You can use the Launcher to log in to and
download the latest version OMDB Client. If the OMDB Client has been upgraded on a
specific OMDB server, you can choose which OMDB server you would like to use for
downloading the OMDB Client.

The OMDB Client Launcher also allows you to configure advanced settings, such as
debug settings, locale settings, and access to the Java Web Start that runs the Launcher
and OMDB Client.

This section contains the following topics:

+ OMDB Client and OMDB Client Launcher Requirements
+ Installing the OMDB Client Launcher

+ Uninstalling the OMDB Client Launcher

+ Launching the OMDB Client

+ OMDB Client Launcher Advanced Options

+ Launching the OMDB Client from the SAS Client

1 O Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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OMDB Client and OMDB Client Launcher Requirements

The OMDB Client is a Java application that installs and runs with its own Java Runtime
Environment (JRE). The OMDB Client will not interfere with any other versions of JRE you
may have installed on your system. The JRE will not be used (and is not usable) by any
other Java application on the target computer, and it will not set itself as the default JRE
on the target computer.

The OMDB Client is supported on the following operating systems:
* Windows 2003
+ Windows 2000
» Windows XP
+ Windows Vista
The minimum systems requirements to run the OMDB Client are as follows:
+ At least 512 MB of DRAM

« If using the OMDB Client to connect to a core using a residential VoIP connection, a
minimum 384 Kbps DSL connection is recommended.

» You need to be logged in as a user that has sufficient permissions to install software
on the computer. (You do not need to be an administrator user to install the launcher.)

To run the OMDB Client, you must download and install the OMDB Client Launcher
(accessible from the OMDB Web Client). In order to install the OMDB Client Launcher,
you will need to be a Windows user that is able to install applications on your system.

Installing the OMDB Client Launcher

In order to run the OMDB Client, you need to download and install the OMDB Client
Launcher, which is a Java application that allows you to access the OMDB Client from any
OMDB server. When you install the OMDB Client launcher, it installs all the necessary
Java applications (Java Web Start and JRE) you need to run the OMDB Client.

If you plan to have multiple users install the OMDB Client Launcher on the same
computer, Opsware recommends that each user choose a unique path to install the
application. For example, if one user has already installed the OMDB Client Launcher in
the default location, C:\Opsware, then if another user logs in to the same computer and

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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attempts to install to that same default location, they will see an error and not be able to

install. If this occurs, choose a new location.

To install the OMDB Client Launcher, perform the following steps:

Open a Web browser, and enter the URL to the OMDB Web Client.
On the OMDB Web Client login page, click the Download Opsware Launcher link.

Download the OMDB Client Launcher installation file and double-click to start the
OMBDB Client Launcher installation.

In the Welcome page of the installation wizard, click Next to begin the OMDB Client
Launcher installation.

In the License Agreement page of the wizard, select the “l accept the agreement”
option, and then click Next to proceed with the installation.

In the Select Destination Directory page, accept the default installation directory, or
click Browse to select a custom location. Click Next.

In the Select Start Menu Folder page, accept the default name and click Next.

In the Select Additional Tasks page, accept the default options or choose your own,
and then click Next to install the OMDB Client Launcher.

When the installation has completed, click Finish to exit the wizard.

Uninstalling the OMDB Client Launcher

You can uninstall the OMDB Client Launcher using the uninstaller provided by Opsware,
or you can use the Windows’ Add/Remove Programs utility located in the control panel on
your system.

To uninstall the OMDB Client Launcher, perform the following steps:

From the Start menu, select » All Programs » Opsware » Opsware Client
Launcher Uninstaller.

In the start page of the uninstaller, click Next to begin uninstalling the SAS Client
Launcher.

When the uninstaller has finished, click Finish to exit. The OMDB Client Launcher
has been uninstalled.

12 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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Launching the OMDB Client

The OMDB Client Launcher allows you to log in to an OMDB server using the OMDB
Client. You also have the option of choosing which OMDB server you want to use to
download the latest version of the OMDB Client, separate from the OMDB server you log
in to. For example, when you log into a OMDB server and that OMDB server has a new
version of the OMDB Client, the new version will automatically be downloaded when you
log in. Using the OMDB Client Launcher, you can choose one core to log in to and a
separate core to download the latest client. This gives you the freedom to not have to
download the OMDB Client every time you log into a different core.

The OMDB Client Launcher only allows you to log on to a OMDB 7.0 core. If you attempt
to log into a pre-OMDB 7.0 core, you will get a 404 page not found Java Web Start error
message and not be able to log on to the core.

If you are running the OMDB Client Launcher on Windows 2000, you may see a missing
DLL error message when you log on. This is a benign error and will not affect the log on
procedure. To fix this so the error message does not appear, install this Microsoft update:
http://support.microsoft.com/default.aspx?scid=kb;en-us;259403&Product=vc6.

To launch the OMDB Client, perform the following steps:
E Start the OMDB Client Launcher from one of two locations:

» On your desktop, double-click the OMDB Client Launcher icon (if you chose to install
one on your desktop during the installation)

Or

« From the Start menu, select » All Programs » Opsware » Opsware OMDB
Client.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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H In the Log In to Opsware OMDB Client window, enter your Opsware OMDB user
name, password, and the OMDB server you want to log in to, as shown in Figure 1-1.

Figure 1-1: Log In to OMDB Client Window

P’ Log In to Opsware OMDB Client @@E|
X

PSWARE

OMDB
Uzer Marme: | W |
Paszsword: | |
Care Server: | W |

[ Cancel ][ hare == ]

The user name is not case sensitive. If you have access to more than one OMDB
server, you can enter the OMDB server’s IP address or name in the core server field.
You must specify port 8443 using the host:port notation at the end of the OMDB
server name.

If this is the first time you are logging into a specific OMDB server, the launcher will
download the latest version of the OMDB Client when you log in. If you would like to
differentiate between the OMDB server you log in to and the core from which you
download the latest version of the OMDB Client, you can change those options by
clicking More in the log in window and configuring your Client Host Server. For
information on this and other advanced OMDB Client Launcher options, see “OMDB
Client Launcher Advanced Options” on page 15.

Click Log In.

If you are asked to accept the certificate from the core server, click Yes. The OMDB
Client now appears.

14 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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OMDB Client Launcher Advanced Options

The OMDB Client Launcher provides several advanced options that enable you to
customize how you log in to Opsware OMDB cores and access the OMDB Client in your
data center. For example, you can configure the OMDB Client Launcher so the OMDB
server you log in to is different from the OMDB server you use to access the latest version
of the OMDB Client. This can be useful so that you do not have to download a new
version of the OMDB Client each time you log in to a OMDB server.

The advanced OMDB Client Launcher options also allow you to:

» Locale (English, Japanese, or Korean)

+ Client Host Server (the server from which you want to download the OMDB Client)

» Debug Settings

+ Advanced Configuration (Java Web Start access)

To configure the OMDB Client Launcher's advanced settings, perform the following steps:
E Start the OMDB Client Launcher from one of two locations:

+ On your desktop, double-click the OMDB Client Launcher icon, if you chose to install
one on your desktop during the installation

Or,

+ From the Start menu, select » All Programs » Opsware » Opsware OMDB
Client.

H nthe Log In to Opsware OMDB Client window, click More. You can set the following
OMDB Client Launcher options:

+ Username: Enter your Opsware OMDB username.
» Password: Enter your Opsware OMDB user password.
+ Core Server: Choose the core server which you want to log into.

» Locale: Choose a locale to match the localized version of the OMDB Client, either
Japanese (ja), Korean (ko), for English (en). English is the default.

+ Client Host Server: Allows you to choose the server from which you want to
download the OMDB Client, which can be separate from the login server.

» Use Core Server: Will use the server set in the Core Server field as the server
you want to use to download the OMDB Client.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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» Use: Enter a core server you want to use to download the OMDB Client.

+ Debug Settings: Debugging options that are captured in the following log file:
C:\<install_dir>\Opsware\javaws.log

+ Enable Debug Logging (Fine): Enables debugging and sends OMDB Client
operations and errors to the log file.

+ Enable Server Method Call Logging: Adds server method calls to the log file.

« Advanced Settings: Click to access the Java Web Start application that runs the
OMDB Client Launcher

When you are finished setting the options, click Log In to log in and make the
changes to the advanced settings. (If you do not log in successfully, any changes
you made will not be saved.)

Launching the OMDB Client from the SAS Client
To launch the OMDB Client from the SAS Client, perform the following steps:

EF Launch the SAS Client. See the Opsware® SAS User’s Guide: Server Automation for
information on how to launch the SAS Client.

H nthe SAS Client, from the Tools menu, select Opsware OMDB Client. See
Figure 1-2. This opens the Log In to OMDB Client window as displayed in Figure 1-1.

Figure 1-2: Launching the OMDB Client

=2 Opsware Server Automation System

File Edit Wiew | Tools | Window  Actions  Help

Global shell
Cpsware OMDE Client
|Server Update Cache Ckrl+FS Z
| Options
|Saved Searches ... w | tE_g adrnin
fdvanced Search '@ Public

B (Optional) To display Search in the Navigation pane, select Search Pane from the
View menu in the OMDB Client.
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OMDB Client

The OMDB Client user interface provides an easy access to OMDB features and
functionality. The OMDB Client user interface has the following main areas:

* Menus

+ Navigation Pane
+ Content Pane

+ Status Bar

Figure 1-3: OMDB Client

& Opsware Operational Management Database

Menus |

Reports
This folder cantains reports for Opsware OMDE

# [ ) Compliance History
® [ Deployment Life Cycle
@ [ Storage Reports

@ [ Process Automation Report

Dashboard %

@) Scheduled Reports

Content
pane

Navigation
pane

>

<
@] Reports
)‘D Advanced Search

{i} Opsware Administration
Status bar

sburnett | Mon Dec 10 12:10 2007 America/Pangrirtung

Menus
The OMDB Client includes the following menus:

« File: This menu enables you to open a new OMDB Client window, close the current
window, or exit all open OMDB Client windows.

« Edit: This menu enables you to cut, copy, paste, and delete text.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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« View: This menu refreshes the current view and shows the latest information from the
core that you are currently logged into. You can also access OMDB features in the
Navigation pane, such as Reports (Reports, Dashboard, Scheduled Reports),
Advanced Search (Search, Quick Search), and Opsware Administration (Schedule
Report options, Dashboard options). The menu also allows you to show or hide the
Search pane.

+ Actions: Depending on the feature that you have selected in the Navigation pane,
this menu enables you to perform OMDB functions.

« Window: This menu enables you to access multiple instances of OMDB Client
windows, if more than one window is open.

* Help: This menu provides help for the OMDB Client. Help F1 provides context-
sensitive help relevant to the current feature window selected or opened (same as
F1). The contents and index will open the SAS Client help system to the main table of
contents.

Navigation Pane

To access OMDB features, select a feature in the Navigation pane. When you select a
feature, the details of the feature appears in the Content pane. You can access functions
related to it through the Actions menu.

Content Pane

Depending on the selection in the Navigation pane (Advanced Search, Quick Search,
Reports, Dashboard, Scheduled Report Options, Dashboard Options), the Content pane
lists the corresponding information.

Status Bar

At the bottom of the OMDB Client Application window, the status bar provides the
following information:

« Informational text (left hand side) about the selected object
» A progress bar active when retrieving information from the core
* The user ID

» The time zone set in the user profile

18 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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Key Terms and Concepts

The following terms and concepts are used in the OMDB feature:

« Configuration Item (CI): An object which can be viewed and managed with Opsware
OMDB. For example SAS Server, NAS Device, SAS Patch Policy.

+ Attribute: A single property of a configuration item, the value of which describes the
behavior of the configuration item. Configuration items can have one or more attributes.
For example, some of the attributes for the configuration item SAS Server includes
hostname, life cycle, agent status, and management IP.

Search

In the OMDB Client, the Search feature allows you to search for any information about
your operational environment that is available in Opsware SAS, Opsware NAS, Opsware
PAS, and any third party systems.

You can also search for storage Database, SAN Switch, Server, and Storage Systems
objects if you have purchased Opsware's Application Storage Automation System (ASAS).
For more information, see the Opsware® ASAS User’s Guide.

Opsware's Application Storage Automation System (ASAS) is a separately licensed
product that requires the Opsware Server Automation System (SAS). To visualize any
storage data in ASAS, you must license a version of Visual Application Manager (VAM) for
Opsware ASAS. If you have not purchased VAM and would like to, contact your Opsware
sales representative.

The OMDB Search feature enables you to perform the following actions:
« Perform a search by using keywords.
« Perform an advanced search by creating search queries.

+ Browse for configuration items in your IT environment.

Search for historical data by selecting the date and time for the search query.

+ Save a search query.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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» Perform actions on search results. You must have Opsware SAS 6.5 installed to perform
actions on SAS results, Opsware NAS 6.0 or later installed to perform actions on NAS
results, and either PAS 2.2 or PAS 7.0 installed to perform actions on PAS results.

» Export search results.
« Customize search results formatting using the Results Options window.

* View Item Browser for search results.

Performing a Search

In the OMDB Client, you can search for configuration items by entering a keyword in the
search text field. The search is carried out against the default displayable attributes
defined for the configuration item in the OMDB data catalog.

The search operation returns only configuration items where you have the data access
S
permissions. See Opsware® OMDB 7.0 Installation Guide for information on OMDB
permissions.

To carry out a search, perform the following steps:

EH From the Navigation pane, select Search. To display Search in the Navigation pane,
select Search Pane from the View menu.

H From the drop-down list, select the type of item that is the target of the search.
Figure 1-4 shows a search for the NAS User named Bob.

Figure 1-4: Simple Search in the OMDB Client

N&S Uzer W |

| Bab [=]

El Enter the search text in the text field. The OMDB Client search feature does not
support a wildcard search and the search is not case sensitive.

B Click to search. The search results appear in the Content pane.
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(Optional) Click on any column heading to sort the search results. You can also

change the order of the columns by dragging the column heading and dropping it

into the desired location.

headings for the search results.

Perform the following steps to customize the column headings:

1. In the Results Options window, from the All Available Attributes list, select the
attributes you want to display as column headings for the search results. Click

Add. The attributes now appear on the right pane. See Figure 1-5.

Figure 1-5: Results Option Window

Result Options...

Configuration ftem: | SAS Server M|

All Available Attributes

Aszet Tag &
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SAS_SERVER ]

Configuration fetm:

Aftribute:

(Optional) Click Results Options to specify the attribute to be displayed as column

3

!Attribute Display Mame Sorting
Server Mame 1 Ascending
Primary IP

perating System 2 Ascending
Manufacturer

lodel
Lifecycle
Gialus of 7

Ok ] [ Cancel ] [ Apply ] [ Help

2. To reorder the attributes, select the attribute in the right pane and then click Up or

Down.

3. To remove the attribute, select the attribute in the right pane and then click

Remove.

4. To change the display name of the attribute in the column heading, select the

attribute in the right pane and then enter a new name in the Column Display

Name field.
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To select the sort order of the attribute on the search results, select the attribute in
the right pane and then select the order number from the Sorting Order drop-
down list.

To sort the search results for an attribute, select the attribute in the right pane and
then select Ascending or Descending from the Sorting Order drop-down list.

To make the sorting order case sensitive, select the attribute in the right pane and
then select the Case Sensitive check box.

Click OK to display the selected attributes as column headings. Click Apply to
save.

To add additional attributes, select the relationship from the Configuration ltem
drop-down list as shown in Figure 1-6. The additional attributes appear in the All
Available Attribute list. Perform the instructions listed in steps 1 to 7 to add or
remove additional attributes.

Figure 1-6: Adding Additional Attributes to the Results Option Window
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(Optional) Click Save to save your search query. The Save Search window appears.
Enter the name of the search and click Save. The name of the saved search cannot
be more than 64 characters. The search is saved in a folder corresponding to the
configuration item types in the Advanced Search location in the navigation pane.
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B (Optional) In the Save Search window, select Save as a Report Definition to create
custom reports. See “Editing a Report Definition File” on page 66 for more
information.

El (Optional) Click Export at the bottom of the screen to export search results. The
Export Results window appears. Enter the location, the file name and the file type
and then click Export Results. You can export OMDB search results as .csv or .html
files.

EIJ (Optional) After you export the search results, you can email the search results by
attaching the exported file to the email. You can also print the search results by
printing the exported file from an application that supports .csv or .html files.

EEl (Optional) To perform an action on the search results, select an item from the
Content pane and then from the Actions menu, select the appropriate action.

Quick Search

Quick Search allows you to browse all the configuration items available in OMDB by
selecting the configuration item and then the attribute and value for that item.

Performing a Quick Search

The search operation returns only configuration items on which you have the data access
permissions. See the Opsware® OMDB 7.0 Installation Guide for information on OMDB
permissions.

To carry out a quick search, perform the following steps:
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H From the Navigation pane, select Advanced Search » Quick Search. Quick
Search is displayed in the Content pane as shown in Figure 1-7.

Figure 1-7: Quick Search in the OMDB Client
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H From the ltem Type list in the Content pane, select the configuration item type you
would like to browse. The list of attribute categories for the selected configuration
item appear in the Attribute Category list.

From the Attribute Category list, select an attribute category.

Bl Select the attribute from the Attribute list and then select the value for that attribute
from the Value list. The search results appear in the content pane.

B (Optional) Click on any column heading to sort the search results. You can also
change the order of the columns by dragging the column heading and dropping it
into the desired location.

@ (Optional) Click Save to save your search query. The Save Search window appears.
Enter the name of the search and click Save. The name of the saved search cannot
be more than 64 characters. The search is saved in a folder corresponding to the
configuration item type in the Advanced Search location in the navigation pane.

(Optional) In the Save Search window, select Save as Report Definition to create
custom reports from your search results. See creating custom reports for more
information.
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B (Optional) Click Export at the bottom of the screen to export search results. The
Export Results window appears. Enter the location, the file name and the file type
and then click Export Results. You can export OMDB search results as csv or .html
files.

El (Optional) After you export the search results, you can email the search results by
attaching the exported file to the email. You can also print the search results by
printing the exported file from an application that supports .csv or .html files.

KK (Optional) To perform an action on the search results, select an item from the
Content pane and then from the Actions menu, select the appropriate action.

Advanced Search

In the OMDB Client, an Advanced Search enables you to create queries on search items.
In the search query, you can specify rules and combine each rule with a logical “And” or
“Or” operator. You can use both the “And” and “Or” operator in a single search query.
Each rule is a combination of an attribute/operator/value that enables you to search for a
specific attribute value for the selected search item. For the search item, depending on
the attribute that you select, the options for the operator and value are displayed.

You can specify the attribute values by entering text or a numerical value in the text field,
or by selecting a value from the drop-down list, or by selecting multiple values from a list
of values in the Select Values window. See Figure 1-8.

Figure 1-8: Advanced Search

@ Advanced Search

Search for Configuration tem: ISAS Server v| Az of Date: | Thuy 0372972007 B Titne:  9.00 PR bt

Matching the following criberis:

| Litecycle v| is one of b | | hanaged
land b | | Reported O3 v| kquals b | |Red Hat Enterprize Linux A5 4
Islnd v| | Agert Status v| kquals v| |OK
[ Search ] [ Result Options.. ] [ Save Search...
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The Select Values window appears when you need to specify multiple values for a rule
containing a “is one of” or “is not one of” operator. In this window, you can select multiple
values from the list or add values to the Additional field. See Figure 1-9.

In OMDB, when you perform a search of any configuration item and you select " Equals”

or “Does not equal" or “Is one of” or “Is not one of” in the operator field, then the values
listed in the Value field depends on the values existing in the OMDB database as of the
selected date. If the other values in the OMDB database are not relevant for the selected
date then those values will not be listed in the Value field.

Figure 1-9: Select Values Window
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You can create complex queries by selecting multiple relationships or in-line blocks for a
configuration item and also multiple rules for each relationship. See Figure 1-10.

Figure 1-10: Complex Query Containing Multiple Relationships
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In a complex query, you can also set the precedence on the Or/And logic for the different
rules in that query. In any query, by default the Or logic takes precedence over the And
logic. In Advanced search, you can use the In-Line Search Block to prioritize the And/Or
logic for rules in a query. See Figure 1-11.

Figure 1-11: Complex Query Containing In-Line Block
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Using Advanced Search you can search for historical data by selecting the date and time
for the search query. You can then compare the historical data with the current results or
create custom reports for both the current search results and the historical search results.
See “Editing a Report Definition File” on page 66 for information on how to create custom
reports.
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Performing an Advanced Search

The search operation returns only configuration items on which you have the data access
N
permissions. See the Opsware® OMDB 7.0 Installation Guide for information on OMDB
permissions.

To carry out an advanced search, perform the following steps:

E From the Navigation pane, select Advanced Search » Advanced Search. The
Advanced Search page appears in the Content pane.

B From the Search for Configuration Item drop-down list, select the item you want to
search. From the As of Date drop-down list select the date and from the Time drop-
down list select the time to carry out the search.

Figure 1-12: Advanced Search in the OMDB Client

@ Advanced Search

Search for Configuration tem: Az of Date: E] Time:
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[ Search ] [ Resutt Options ] [ Save Search

E Create a rule by selecting the attribute from the first drop-down list. Depending on
the attribute that you select, options available for the operator and values for the rule
could change.

Bl Select the operator from the second drop-down list. The operator selected defines
how the search text is treated.

B Enter a value in the field or select a value from the drop-down list or click [ to
select multiple values from the Select Values window.

@ Click to add additional rules and repeat steps 3 to 5. Click E] to delete any
rules.

Select the logic (And/QOr) to be applied for every rule in the query.

(Optional) To add a relationship to the search query, select the relationship (indicated
in italics) from the left-most drop-down list. Create rules by following instructions
listed in steps 31to 7.
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El (Optional) To set precedence for any rule in a query, select In-Line Search Block from
the first drop-down list. Then create rules for the query by following instructions listed
in steps 3to 7.

K Click Search to run the search query. The search results appear in the Content pane.

EEl (Optional) Click on any column heading to sort the search results. You can also
change the order of the columns by dragging the column heading and dropping it
into the desired location.

EH (Optional) Click Results Options to specify the attribute to be displayed as column
headings for the search results. Perform the following steps to customize the column
headings:

1.

In the Results Options window, from the All Available Attributes list, select the
attributes you want to display as column headings for the search results. Click
Add. The attributes now appear on the right pane.

To reorder an attribute, select the attribute in the right pane and then click Up or
Down.

To remove an attribute, select the attribute in the right pane and then click
Remove.

To change the display name of the attribute in the column heading, select the
attribute in the right pane and then enter a new name in the Column Display
Name field.

To select the display order of the attribute on the search results, select the
attribute in the right pane and then select the order number from the Sorting
Order drop-down list.

To order the search results for an attribute, select the attribute in the right pane
and then select Ascending or Descending from the Sorting Order drop-down list.

To make the sorting order case-sensitive, select the attribute in the right pane and
then select the Case Sensitive check box.

Click Apply to display the selected attributes as column headings. Click OK to
close the window.

To add additional attributes, select the relationship from the Configuration ltem
drop-down list as shown in Figure 1-6. The additional attributes appear in the All
Available Attribute list. Perform instructions listed in steps 1 to 7 to add or remove
attributes.
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EEl (Optional) Click Save to save your search query. The Save Search window appears.
Enter the name of the search and click Save. The name of the saved search cannot
be more than 64 characters. The search is saved in a folder corresponding to the
configuration type in the Advanced Search location in the navigation pane.

EE (Optional) In the Save Search window, select Save as Report Definition to create
custom reports. See creating custom reports for more information.

EH (Optional) Click Export at the bottom of the screen to export search results. The
Export Results window appears. Enter the location, the file name and the file type
and then click Export Results. You can export OMDB search results as .csv or .html
files.

Ed (Optional) After you export the search results, you can email the search results by
attaching the exported file to the email. You can also print the search results by
printing the exported file from an application that supports .csv or .html files.

(Optional) To perform an action on the search results, select an item from the
Content pane and then from the Actions menu, select the appropriate action.

Exporting Search Results

To export search results, perform the following steps:

E Perform a search in the OMDB Client. The search results appear in the Content pane.

H Click Export at the bottom of the screen to export search results. The Export Results
window appears.

Enter the location, the file name and the file type and then click Export Results. You
can export OMDB search results as .csv or .html files.

Running a Saved Search Query

To run a saved search query, perform the following steps:

E From the Navigation pane, select Advanced Search » Advanced Search.

H Navigate the folder hierarchy to select the search query. The search results will
appear in the Content pane.

Deleting a Saved Search

To delete a saved search query, perform the following steps:

E Fom the Navigation pane, select Advanced Search » Advanced Search.
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H Navigate the folder hierarchy to select the search query. The search results will
appear in the Content pane.

Click Save. The Save or Delete your search window appears as shown in Figure 1-
13.

Figure 1-13: Save or Delete Your Search
Save or. Delete your search E'

Search Name
| Search for NAS Device |

Saved Searches

Search for SAS Server

|:| Save as a Report Definition

[ Save ] [ Delete ] [ Cancel

Bl Select the saved search and click Delete. Click Delete on the Confirmation window
to delete a saved search.

Item Browser

The Item Browser in the OMDB Client allows you to view all the available attributes for the
selected configuration item. The [tem Browser enables you to view additional information
about the configuration item and its relationships.
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The Iltem Browser consists of two main components: the Views pane and the Content
pane. The Views pane lists all the available attribute categories for the selected
configuration item, and the Content pane displays the details of the selected attribute.
When you select an attribute in the Views pane, its corresponding details appear in the
Content pane. See Figure 1-14.

Figure 1-14: Item Browser
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The list of attribute categories in the Item Browser varies depending on the configuration
item returned in the search or report results. For example, Figure 1-14 shows an Item

Browser for the configuration item SAS server, and Figure 1-15 shows an Item Browser for
the configuration item NAS device switch.

Figure 1-15: Item Browser for NAS Switch
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Accessing the Iltem Browser
Perform the following steps to access the Item Browser:
E nthe OMDB Client, perform a search or run a report.

H Select an item from the search or report results and then from the Actions menu,
select View. The ltem Browser for the selected configuration item appears.
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This section discusses the following topics:
+ Overview of OMDB Reports

+ Reports Features

+ Opsware OMDB Client Reports
+ User Permissions

+ Launching the Reports Feature
+ Reports Display

* Running a Report

+ Report Results

» Exporting a Report

+ Printing a Report

« Saving a Search as a Report

« Scheduling a Report

Overview of OMDB Reports

The Opsware OMDB Client Reports feature provides comprehensive information about
managed servers, network devices, software, patches, customers, facilities, operating
systems, compliance policies, and users and security in your environment. These
parameterized reports are presented in graphical and tabular format, and are actionable—
which means that you can perform appropriate actions on objects, such as a policy or an
audit, within the report. These reports are also exportable to your local file system (as
.html, .pdf and xls files) to facilitate use within your organization.
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You can also search for storage Database, SAN Switch, Server, and Storage Systems
objects if you have purchased Opsware's Application Storage Automation System (ASAS).
For more information, see the Opsware® ASAS User’s Guide.

Opsware's Application Storage Automation System (ASAS) is a separately licensed
product that requires the Opsware Server Automation System (SAS). To visualize any
storage data in ASAS, you must license a version of Visual Application Manager (VAM) for
Opsware ASAS. If you have not purchased VAM and would like to, contact your Opsware
sales representative.

This section contains information about the types of OMDB Client reports, how to modify
report parameters, how to run the reports, and how to perform actions in the report
results.

Reports Features

The OMDB Client Reports enable you to perform enterprise health assessments by
providing the following features:

« Actionable reports that enable you to take the appropriate action on objects within the
reports. For example, in the list view of a compliance report, you can select a server
and open a Remote Terminal or Server Explorer to browse it, perform an audit, create a
snapshot, create a package, and so on.

+ The OMDB Client Dashboard provides a display of selected reports. See “OMDB
Dashboard” on page 57.

* Reports that are data-secured—controlled by the user’'s permissions to the data.
» Reports that can be run on either current or historical data.

» Reports that are printable and also exportable to .html, .pdf, and xIs formats. You can
export reports to your local file system for use within your organization.

» Custom reports can be created and imported. See “Editing a Report Definition File” on
page 66.

» Reports that can be scheduled to run automatically and to email the results to you and
others.

36 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.



Chapter 2: OMDB Reports

Opsware OMDB Client Reports
Table 2-1 lists the OMDB Client Reports by report folders.

Table 2-1: OMDB Client Reports

Compliance History

Deployment Life Cycle

Device Compliance History - Provides a detailed compliance
state history for all servers, or for one or more selected servers

Device Group Compliance History - Summarizes the compli-
ance history of devices in a specified device group

Customer Compliance History - Summarizes the compliance
history of devices assigned to a specified customer

Facility Compliance History - Summarizes the compliance his-
tory of devices in a specified facility

Devices By Type - Filters network devices by group, and non-
network devices by customer, facility, or group

Network Devices By Device Type - Provides a deployment
trend history for the network devices in a specified group,
organized by device type

Servers By Operating System - Provides a deployment trend
history for the servers in a specified customer, facility or group,
organized by operating system and version

Servers By Architecture - Groups the servers in a specified
customer, facility or group organized by architecture
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Storage Reports - Host
and Application Stor-
age Reports

Host Capacity and Utilization Overview - Provides detailed
capacity & utilization information for multiple hosts, potentially
grouped by customer, facility or device group.

Host Capacity and Utilization Trend Data - Provides detailed
capacity & utilization trend data for a collection of hosts,
grouped by customer, facility or device group.

Host Total Storage Utilization Trend - Provides total storage
utilization rate for a set of hosts (grouped by customer, facility
or device group), has changed over time and is projected to
change in the future.

Host Total Storage Allocation Trend - Provides total allocated
and used storage for a set of hosts (grouped by customer,
facility or device group), has changed over time and is
projected to change in the future.Host Volume Manager
Storage Utilization Trend - Provides volume manager storage
utilization rate for a set of hosts (grouped by customer, facility
or device group), has changed over time and is projected to
change in the future.

Host Volume Manager Storage Allocation Trend - Provides
allocated and used volume manager storage for a set of hosts
(grouped by customer, facility or device group), has changed
over time and is projected to change in the future.

Host DB Storage Utilization Trend - Provides database storage
utilization rate for a set of hosts (grouped by customer, facility
or device group), has changed over time and is projected to
change in the future.

Host DB Storage Allocation Trend- Provides allocated and
used database storage for a set of hosts (grouped by
customer, facility or device group), has changed over time and
is projected to change in the future.
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Storage Reports - Host | Host Filesystem Storage Utilization Trend - Provides filesystem

and Application Stor- storage utilization rate for a set of hosts (grouped by customer,
age Reports facility or device group), has changed over time and is
(continued) projected to change in the future.

Host Filesystem Storage Allocation Trend - Provides allocated
and used filesystem storage for a set of hosts (grouped by
customer, facility or device group), has changed over time and
is projected to change in the future.

Host Reclaimable Storage Overview - Provides capacity
information grouped by hosts.

Host Storage Detail- Provides detailed storage information for
a selected host.
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Storage Reports - Data- | Tablespace Capacity and Utilization Overview - Lists

base Storage Reports

Storage Reports - Stor-
age Array Reports

tablespaces and their capacity and utilization information,
grouped by database.

Database Utilization Trend - Provides how utilization
information for a set of databases has changed over time and
is projected to change in the future.

Database Allocation Trend - Provides how allocated and used
capacity for a set of databases has changed over time and is
projected to change in the future.

Database Capacity and Utilization Trend Data - Provides
detailed capacity and utilization trend data for a set of
databases.

Tablespace Utilization Trend - Provides how utilization for a set
of tablespaces within a specific database has changed over
time and is projected to change in the future.

Tablespace Allocation Trend - Provides how allocated and
used capacity for a set of tablespaces within a specific
database has changed over time and is projected to change in
the future.

Tablespace Capacity and Utilization Trend Data - Provides
detailed capacity and utilization trend data for a set of
tablespaces.

Array Inventory- Provides basic inventory information and
storage statistics for SAN storage arrays and NAS filers.

Array Capacity & Utilization Overview - Provides summary
capacity & utilization statistics for SAN storage arrays and NAS
filers, grouped by Customer, Facility or Device Group if desired.

Storage Allocated to Hosts Unmanaged By ASAS - Provides
summary of storage capacity allocated to unmanaged hosts.

Array Detail -Provides a detailed inventory of storage-related
information pertaining to a specific storage array or filer.
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Zone Inventory - Provides the zone configuration for a
specified zone set.

PAS Run History Summary By Device - Provides device impact
for PAS workflows sorted by device.

PAS Run History Summary By Flow - Provides device impact
for PAS workflows sorted by flow.

PAS Run History Details By Device - Provides device impact for
PAS workflows sorted by device.

PAS Run History Details By Flow - Provides device impact for
PAS workflows sorted by workflow.

Reports are controlled by the user's permissions to access the data. If a user does not
have permissions to view a set of servers, those servers will not display in a report run by

that user.

Launching the Reports Feature

To launch the Reports feature, perform one of the following steps:

« From the Navigation pane, select Reports.

* From the View menu, select Reports » Dashboard.

* From the View menu, select Reports > Reports.

« From the Navigation pane, select Scheduled Reports.
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Reports Display

The Reports feature display consists of a Search pane, a Dashboard, Scheduled Reports,
report folders, and report parameters.

Figure 2-1: The Reports Feature Display
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Search Pane

In the Reports feature, you can use the OMDB Client Search feature to find reports by
defining specific filter criteria. You can save a search as a report definition and create
custom reports.

Dashboard

The Dashboard provides a display of selected reports. See “Overview of Dashboard” on
page 57 for more information.
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Report Folders

Reports are organized in the following folders according to regulatory or IT best practice
standards:

« Compliance History: This folder contains reports about compliance for software
policies, audit policies, and patch policies by servers, customer, and facility.

- Deployment Life Cycle: This folder contains reports about attributes of servers and
network devices.

« Storage Reports: This folder contains reports about attributes of storage servers and
arrays.

* Process Automation Reports: This folder contains process automation reports.

» Custom Reports: This folder contains any custom reports you have created. If no
custom reports exist, then the Custom Reports folder is not present. For more
information on creating custom reports, see ““OMDB Custom Reports” on page 65.
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« Figure 2-2 illustrates the Report folders in the Navigation pane, including the reports
you will find in each folder.

Figure 2-2: Report Folders
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Report Parameters

Many reports require input parameters in order to be run. For reports that require
parameters, you can run the report with its default parameter values or modify the
parameter values. If you want to run a report that includes or excludes certain servers,
customers, or hardware models, you need to specify this criteria in the report parameters.
See “Running a Report” on page 45.
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Running a Report

To run a report, perform the following steps:

E From the Navigation pane, select Reports.

Expand the Reports folder and then expand Compliance History.
Select one of the reports listed in the folder.

If there are no report parameters in the Content pane, click Run.

If there are report parameters in the Content pane, you can either use the default
parameters or change them:

» To use the default report parameters, click Run to run the report.

» To change the report parameters, see “Modifying Report Parameters” on page 45.
Modifying Report Parameters
You can modify the default parameters of a report. If you modify the parameters of a
report, your changes become your default settings for that report. To modify the default

parameters and run a report that includes certain servers, customers, hardware models,
and so on, perform the following steps:

E (Optional) Select the date.
H (Optional) Select the interval.

E (Optional) You can select Use Relative Dates to set the date and interval as relative to
when the report is run in the future. See “Setting the Use Relative Dates Parameter”
on page 46.

Bl n the drop-down list for (the Server, Customer, Model, and so on), select one of
Contains, Equals, Begins With, or Ends With.

B (Optional) Click the ellipsis (...) button to the right of the [Any Value] fields to open the
Select Values window.

@ Inthe Select Values window, select a value in the Available or Selected pane and
then use the directional buttons to include it in or exclude it from your search criteria.

Click OK to save your changes.

Click Run to run the report.
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If data cannot be found to run the report, “No records to display!” displays.

Setting the Use Relative Dates Parameter

The Use Relative Dates parameter sets the date and interval as relative to when the report
is run in the future. Relative dates are calculated in absolute dates offset from the current
date. For example, you run a report on October 26 of this year, and select the date and
interval of the report to run from October 24 to October 25. Scheduling this report to run in
the future without selecting Use Relative Dates will present the results for October 24 to
October 25 of this year. Selecting Use Relative Dates causes the report to present the
results of yesterday and the day before yesterday, relative to whenever the report is run.

Report Results

Report results initially appear in a graphical or list view. The graphical report is an
overview of available data for this report displayed in a pie chart or in a bar graph.
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Graphical Report

A graphical report is a bar graph or a pie chart. See Figure 2-3 for an example.

Figure 2-3: Bar Graph
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List Report

A list report is a tabular display of information. Double-click on a row in the list, such as a
server, audit, or policy, for more detail or to perform an action. See Figure 2-4 for an
example.

Figure 2-4: List Report
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Exporting a Report

You can export a report for use in other applications in your environment and attach a
report for email distribution. Depending on the report format, you can export a report to
your local file system as an .html file, a .pdf file, or an xls file.

To export a report, perform the following steps:
E From the report, click Export to open the Save window.

H nthe Save in field, enter a location that identifies where you want to save the file to,
or select from the drop-down list.
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B Select the file type.

B Enter a file name.

B Click Save.

Printing a Report

To print a report, perform the following steps:

E From the report, click Print to open the Print window.

H Use the default print options or modify them, and then click OK.

Saving a Search as a Report

Using the OMDB search engine you can generate rich SQL queries and save them as
BIRT reports. In this example, you will use the OMDB search engine to look at the SAS
Server configuration items in the enterprise and save the search parameters as a report.

To customize the report definition file you create in this task, see “Editing a Report
Definition File” in Chapter 4, “OMDB Custom Reports”.

To perform a search and save that search as a report, perform the following steps:

E nthe OMDB Client, in the Search pane, select Advanced Search » New Search.

H Select the SAS Server configuration item from the Search for Configuration Item
drop-down list.

E To find all servers with a reported OS value of either Linux or Windows, perform the
following steps:

1.

o o~ N

Select the Reported OS criteria and Contains from the drop-down lists.
Enter Linux in the next field, and then click the plus (+) button.
Select or from the drop-down list.

Select Reported OS criteria from the drop-down list.

Select Contains criteria from the drop-down list.

Enter wind in the next field.
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Bl Click Search to generate the screen illustrated in Figure 2-5.

Figure 2-5: Search Screen
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These results are sorted by the first column, Server Name.

B Click Result Options to specify a different sort priority.
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The Result Options window shown in Figure 2-6 allows you to select Attributes to
sort, and to set the order in which each is considered.

Figure 2-6: Sort Order
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a
B Click OK.

In the Attribute Display Name column, select Operating Systems.

In the Sorting Order drop-down list, select 1.
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The sorted results of this modified search appear in Figure 2-7 below. Red Hat
precedes SuSE, which is followed by VMware, then is followed by the Windows
family of operating systems.

Figure 2-7: Results Sorted by Operating System
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You can assign a name to the selection criteria used for this search, and save it as a
report. At a later date, you could select the report from the OMDB Client and run it
again.

You can also save this search as a BIRT report. Doing so will allow you to open the
report in BIRT to edit its appearance and functionality.

El Click Save Search.

E Save the search with a descriptive name, so that you can run it in the future from the
OMDB Client. In the Search Name field shown in Figure 2-8, enter a Search Name,
such as SAS Server_ Search.
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EEl Select Save as a Report Definition.

Figure 2-8: Save or Delete Your Search
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Scheduling a Report

You can schedule a report to run at a specified time, and to repeat at intervals. The report
can be emailed to one or more recipients when it runs.

To
(1]

schedule a report, perform the following steps:

From the report, click Schedule to open the Scheduled Report Options window
shown in Figure 2-9.

In the Schedule Name field, enter the name. The default value is the report type
name.

Select the frequency, either Once, Daily, Weekly, or Monthly.
(Optional) Select the options available for Daily, Weekly, and Monthly, as appropriate.

Set the Start Time.
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Set the Start Date.
(Optional) Select End recurring schedule by, and then set the end date.

B In the Recipients field, enter one or more email addresses. If you are entering,
multiple addresses, the addresses can be separated by a space, comma, semicolon,
or a Return.

El Select a format for the report output.
X Click OK.

Figure 2-9: Scheduled Report Options
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Setting Scheduled Report Options

For scheduled reports an Administrator can set the following options:
« Maximum number of scheduled reports each user can enable

* Number of scheduled reports concurrently processed by server

The ‘Maximum number of scheduled reports each user can enable” option allows an user
only to enable the number of reports as set by the administrator. This option does not
prevent the user from creating an unlimited number of scheduled reports.

An administrator can lower the number of scheduled reports to below the number of
scheduled reports a user currently has configured. The next time the user updates or
creates a scheduled report, the user will need to disable some of their scheduled reports
down to the current maximum number of scheduled reports. This option also will not allow
the user to save changes to a scheduled report if they have already matched the
maximum number of scheduled reports.

The “Number of scheduled reports concurrently processed by server” option enables an
Administrator to monitor that the server that processes scheduled reports are running
smoothly. This setting is designed to keep the server from crashing due to an excessive
number of reports being scheduled at the same time.

In the event that there are more scheduled reports scheduled to run at a specific time
than specified in this value, then the server will process the scheduled reports in batches
of the size specified in this value. Therefore, sometimes reports may not run at the time as
specified by the user. Running some reports may be delayed due to server load.

To set the options for scheduled reports, perform the following steps:

E nthe OMDB Client, from the Navigation pane, select Opsware Administration »
Scheduled Report Options. The Scheduled Report Options options appears in the
Content pane.

H Enter the value for the maximum number of scheduled reports each user can enable
option.

E Enter the value for the number of scheduled reports concurrently processed by
server.

Bl Click Save to save the Scheduled Report options.
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This section discusses the following topics:
+ Overview of Dashboard
+ Viewing the OMDB Dashboard

+ Setting Dashboard Options

Overview of Dashboard

The OMDB Dashboard displays useful summary type OMDB reports allowing you to view
important reports on a daily basis. It contains one or more of the following summary
reports in a graphical format:

* Devices by Type

« Servers by Operating System
* Network Devices by Type

« Servers by Architecture

You can drill down to the summary report to view the complete report in detail. In the
Dashboard, you can perform the following actions on the summary reports:

* Print reports
» Export OMDB report results as .html, .pdf, or xIs files
» Drill down the summary report to view the complete report in detalil

» Perform action on report results
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By default, the Dashboard contains the following five summary reports as shown in
Figure 3-1:

Compliance % Over the Last 30 Days: This report displays the compliance history of
servers and network devices over the last 30 days at daily intervals.

Devices by Type Over the Last 30 Days: This report displays the devices (servers and
network devices) deployed over the last 30 days at daily intervals.

Servers by Operating System Over the Last 30 Days: This report displays the
servers organized by operating system and version over the last 30 days at daily
intervals.

Network Devices by Type Over the Last 30 Days: This report displays the network
devices (such as routers, switches) deployed over the last 30 days at daily intervals.

Servers by Architecture Over the Last 30 days: This report displays the servers
organized by CPU architecture over the last 30 days at daily intervals.
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Figure 3-1: OMDB Dashboard
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In the OMDB Client, you can also create and configure your own personal Dashboard. You
can select up to eight reports to be displayed in your Dashboard from the list of reports
mentioned above. You can also configure your Dashboard to be in either a one-column or
two-column layout. See “Setting Dashboard Options” on page 60 for more information.

When you launch the OMDB Client, by default the Search feature is displayed in the
Content pane. You can also configure the dashboard options to display the Dashboard
feature in the Content pane when you first launch the OMDB Client. See “Setting
Dashboard Options” on page 60 for more information.

Viewing the OMDB Dashboard

To view the Dashboard in OMDB, perform the following steps:

H Inthe OMDB Client, from the Navigation pane, select Reports » Dashboard. The
default Dashboard appears in the Content pane.

B To create your personal Dashboard, see “Setting Dashboard Options” on page 60.

(Optional) To view the complete report in detail, click on any report in the Dashboard.
The complete report appears in the Content pane.

Bl (Optional) Click Export to export the reports displayed in the Dashboard. The Export
Results window appears. Enter the location, the file name and the file type and then
click Save. You can export OMDB report results as .html, .pdf, or xls files.

(Optional) Click Print to print the reports displayed in the Dashboard.

(Optional) To perform an action on the report results, select an item from the Content
pane and then right-click to select the appropriate action.

Setting Dashboard Options

In the OMDB Client, you can create and configure your own personal Dashboard. You can
select up to eight reports to be displayed in your Dashboard and specify the parameter
values for those reports. You can also configure your Dashboard to be in either a one-
column or two-column layout.
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To configure the Dashboard options, perform the following steps:

E nthe OMDB Client, from the Navigation pane, select Opsware Administration »
Dashboard Options. The Dashboard options appears in the Content pane.

Figure 3-2: Dashboard Options
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Save Layout

H From the Startup Location options, select an option to be displayed every time you
launch the OMDB Client. You can select either Reports, Search, or Dashboard. Select
the Dashboard option to display the Dashboard feature when you launch the OMDB
Client.
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E From the Dashboard Selector options, select Custom Dashboard to configure your
Dashboard using the reports that are available.

Bl From the Custom Dashboard Column Selector options, select One Column to display
the reports in a one-column format in the Dashboard. Select Two Columns to display
the reports in a two-column format in the Dashboard.

H To configure a report in the Dashboard, perform the following steps:

Different reports have different report parameters to configure. For example, for the report

"Network Devices by Device Type," you can configure the parameters such as Device
Group, Vendor, and Model. For the report “Servers by Operation System”, you can
configure the parameters such as Customer, Facility, and Device Group.

1. From the Custom Dashboard Configuration Panel in Report 1, select a report from
the Report File drop-down list.

2. (Optional) Enter the report title in the Title field, or the default report name will be
used for the report title.
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3. Click Configure. The Report Dialog window appears.

Figure 3-3: Report Dialog Window
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4. From the Date Range drop-down list, select a date range to run the report.

5. From the Interval drop-down list, select the time interval to run the report. The
Interval drop-down list allows you to group the data on a daily, weekly, or monthly
time interval.

6. From the Customer drop-down list, specify the customer to be included or
excluded in the report.

7. From the Facility drop-down list, specify the facility to be included or excluded in
the report.
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8. From the Device Group drop-down list, specify the device group to be included or
excluded in the report.

9. Click Run. The report with the specified parameters is displayed in the Content
pane.

10. Click OK to save your changes or click Cancel to close the window.
@ To configure more reports, repeat the steps listed in Step 5.

Click Save Layout to save the Dashboard options.
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This section discusses the following information:

* Introduction

« Designing a Report

+ Editing a Report Definition File

+ Inserting a Chart

+ Integrating a Custom Report into the OMDB Client
+ Creating OMDB Reports

« Parameter Substitution Configuration

+ Parameter Substitution of Dates

+ Actionability

Introduction

The Opsware family of products is comprised of a cluster of Oracle databases, typically
running on a Sun Microsystems minicomputer. These databases are continuously
refreshed and updated by agents residing on the managed servers and workstations in
the network.

Opsware SAS enables you to create and design reports and integrate them into the SAS
Client and the OMDB Client.

This chapter presents how to use content selected from these databases and create
custom reports. It explains how to create a simple SQL query, how to design a report, and
how to integrate it into the Opsware OMDB user interface.

The recommended authoring environment for custom OMDB reports includes the
following items:

» A file transfer tool
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+ An SQL query tool

+ Business Intelligence and Reporting Tools (BIRT) RCP Designer
(http://www.eclipse.org/birt) BIRT release 2 1 _1

BIRT library file cmdb-data-sources.rptlibrary

JDBC driver file ojbcl14.jar

Designing a Report

Begin your report design by defining its content. To define the report’s content, you should
determine the report’s purpose, the type of information displayed, and the logical
grouping of the data set. Then, you can map the content definition into the product-
specific database schema by determining how Opsware should represent the data
needed, the names of the tables where the data is stored, and the names of all of the
fields within those tables.

Using this information you can write the SQL query that Opsware will use to generate the
report. Writing the correct SQL query is the most difficult part of report creation. The
standard reports contain a set of queries that are good candidates to borrow work from.
The report (.rptdesign) files can be found in an installed OMDB core at /opt/opsware/
omdb/reports. Whether borrowing from existing reports or creating original content,
consider using a tool such as PL/SQL Developer to refine and optimize your SQL.

When you have optimized the SQL, you should test your SQL query to ensure that the
SQL is valid and returns the expected data.

No AAA-specific considerations need to be made in your SQL. The report engine will
automatically transform the SQL that you have created at runtime to constrain the report
results to what the current user can see.

Editing a Report Definition File
H Inthe OMDB Reports chapter, perform the task “Saving a Search as a Report”.

A Start BIRT 2.1.1. In a Windows command prompt, run the command birt .exe.

B Openthe sAs Server Search.rptdesign file that you just created.
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As shown in Figure 4-1, the new report contains the form and content of the
information you selected when defining the report. The header information is already

in place.

Figure 4-1: New Report in BIRT
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In the Outline pane, expand Data Sources, and then double-click the Data Source

B View the information for the new JDBC Data Source as shown in Figure 4-2.
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@ Click Test Connection to ensure that the report is connected.
Figure 4-2: JDBC Connection

bl New JDBC Data Source Profile x|

Create a new data source

<
Create a new data source

Driver Class:

Database URL: | jdbc:oracle:thin:@cmdb, opsware, com: 1521 :cmdb
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< Back [ext = | Einish I Cancel
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Select the Preview tab, and review the report.

Figure 4-3: Preview Tab
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B Click on the XML Source tab to see the SQL query that the OMDB Client generated.

Figure 4-4: XML Source Tab
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El To group the output by operating system, select the top cell in the header row, right-
click and select Insert Group from the menu as shown in Figure 4-5.

Figure 4-5: Inserting a Group
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In the next window shown in Figure 4-6, you can select the column that provides the

group identity.
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K Select COLUMN_10 to specify the Reported OS column.

Figure 4-6: New Group Creation
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EEH Click OK.
EH Select the Layout tab.
EE Select the Properties tab.
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KA Select the font properties to make this field smaller and darker.

Figure 4-7: Font Properties
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As shown in Figure 4-8, the report now groups the output by operating system.

Figure 4-8: Preview of Grouped Report
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Inserting a Chart

BIRT can generate a chart to visually display selected elements of the output. Figure 4-9
displays the detailed SQL query that the SAS OMDB Client created. This is the search-
Result-Dataset based on the cust-DataSource data source.

Figure 4-9: SQL Query
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To create a new data set based on the same cust-DataSource data source, perform the
following steps.

E From the Data menu, select New Data Set.

Figure 4-10: New Data Set
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H To learn how many instances of each operating system are currently online, in the
Query pane type the SQL statements Select Count (*) From and Group By. Then,
drag the desired Available Items from the middle pane to their places in the query
text.

The final SQL statement is:

select CMDB_DATA.SAS SERVERS.REPORTED OS,
count (*) from CMDB_DATA.SAS SERVERS
group by CMDB_DATA.SAS SERVERS.REPORTED_ OS

Figure 4-11: Data Set Query
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H Click OK.

Bl Drag the Chart icon from the Palette tab to the Layout panel.
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From Select Chart Type menu, select Pie Chart.

Figure 4-12: Chart Type
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@ Click Next. A screen similar to Figure 4-13 appears.

Figure 4-13: New Chart
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To bind a data column ko the chart, use the right-click menu or drag the column to

the appropriate text field,
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Parameters. ., |
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From the Select Data Set option, select Use Data Set, and then select Data SubSet
from the drop-down list. The Data Preview pane displays the contents of the data set.

Drag the COUNT(*) header to the Slice Size Definition field.

Drag the REPORTED_OS header to the Category Definition field.
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KXY Click Next.

Figure 4-14: Report Operating Systems
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EEl Select the Chart Area line to call up the input fields. You can use these to assign a
chart title and to define the background.

EH Click Finish.
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As shown in Figure 4-15, the Layout view displays an icon of the chart, rather than
the chart itself.

Figure 4-15: Layout View of Chart
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Drag the chart icon to the top of the report.
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KB Pull the handles on the icon to expand it.

Figure 4-16: Chart Icon
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K Click Preview.

Figure 4-17: Report Preview
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Integrating a Custom Report into the OMDB Client
To integrate the report into the OMDB Client, perform the following steps:

El Copy the custom report to the /opt /opsware/omdb/reports directory. Repeat
this step for additional cores as needed; report files are not automatically replicated.

B To see this report listed in the OMDB Client, add it to custom_def . xml.
To edit custom_def .xml to include the report, perform the following steps:

E Modify the custom_defxml file in the /opt /opsware/omdb/deploy/birt .war
directory that the OMDB Client uses to recognize, display, and invoke the reports
stored on each core. If you are using WinSCP, you can double-click on the custom
def .xml file name to open the document for editing.
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Insert a description of your report in the top part of the .xm1 file. The easiest way to
do that is to copy an existing report definition, paste it in, then modify the report
name, display name, and description to match your new custom report.

In the following sample text, the new report is defined in the bold text.

<reporting>
<reports>
<location>/etc/opt/opsware/occ/reports</location>
<report name="ServerByOSChart.rptdesign">
<display name>ServerByOSChart Title</display
name>
<description>ServerByOSChart Desc</descriptions>
<parameters>
</parameters>
</report>
<report name="SAS Server Search.rptdesign">
<display name>SAS Server_ Search</display name>
<description>SAS Server Search</descriptions>
<parameters>
</parameters>
</report>

In the custom_def . xml file, modify the folder section to specify where the new
report will go. In the following example, we are telling the SAS Client to make the
sample report available in the Compliance Reports folder.

<folder name="compliance reports">
<display namescomplianceReportsFolderDesc</
display name>
<folder reports>
<report name>
ServerConfigurationPolicyComplianceChart.rptdesign</report
name>
<report name>SAS Server Search.rptdesign</report names

<report
name>ApplicationPolicyComplianceChart.rptdesign</report
name>
<report name>
ApplicationPolicyComplianceTableByCustomer.rptdesign</
report name>
<report
name>ApplicationPolicyComplianceByFacility.rptdesign</
report name>
</folder reportss
<subfolderss>
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<subfolder namessox</subfolder names>
</subfolders>
<parent>reports</parent>
</folders>

The custom_def . xml file must have user and group ownership set to omdb : omdb or

S
the OMDB Client will not see it.

When you use the OMDB Client, you can view and run your new report.

Creating OMDB Reports

To create an OMDB report, perform the following steps:
E Launch BIRT RCP Designer.
H Select File » New » New Report. The New Report window appears.

E Select a directory to save the report into. The directory must contain the following two
files:
opsw-common-reporting.rptlibrary
cmdb-data-sources.rptlibrary

These two files are located in /opt/opsware/omdb/reports/resources.
Type the file name in the File Name field.
Click Next.

(Optional) Select a report template.

[~ o I o I

Click Finish.

Click the Library Explorer tab.

El Expandthe cmdb-data-sources.rptlibrary item.

I Select cndb-jdbe.

EEl Drag cmdb-jdbc to the Outline pane, onto the Data Sources folder icon.

EH Click the Data Explorer tab,

EEl Right-click Data Source » cmdb-jdbc. The Edit Data Source window appears.

KB View the data connection in the Edit Data Source window shown in Figure 4-18.
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E To test the data connection, click Test Connection.
Figure 4-18: Edit Data Source

pifi Edit Data Source - Data Source

=10l x|

- Property Binding

Database URL: | jdbec:oracle:thin:@cmdb, opsware . com: 1521 :cmdb
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Manage Drivers... | Test Connection..,

Ok I Cancel
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EI3 Create and name a new data set as shown in Figure 4-19 and Figure 4-20.
Figure 4-19: New Data Set
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Figure 4-20: Name New Data Set
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Click Next.
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EE] Create the SQL query. Drag and drop the selected data rows into the SQL panel on
the right, remembering to add SQL commands, commas, and spaces, as needed.

Figure 4-21: Creating SQL Query
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EE] Click Preview Results to see if the SQL parses and runs.

Figure 4-22: Preview Results
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X Drag the Table icon from the Palette to the middle row of the layout grid.
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EXl \When the Insert Table window appears, set the number of columns to three.

EF Drag the desired fields from the Outline tab on the left into position on the table.

Figure 4-23: BIRT RCP Designer
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EXA Integrate the new report into the Opsware OMDB Client. The procedure is described
in “Integrating a Custom Report into the OMDB Client” on page 82.

Parameter Substitution Configuration

Parameter substitution can be configured in one of two ways:
» Using the opsw-common-reporting Report Library
+ Using the com.opsware.reporting.util package

Using the opsw-common-reporting report library is recommended.

Using the opsw-common-reporting Report Library

To enable parameter substitution in a custom report using the opsw-common-reporting
report library, perform the following steps:

B From the opsw-common-reporting Report Library, add the Report items »
Grid - Report Header to the report.

H Add the following short script to the beforeOpen script:
queryText = prepareSql (queryText) ;

Using the com.opsware.reporting.util package

Report parameter substitution is not supported in local previews using the
com.opsware.reporting.util package. To test this feature, you must deploy it to
the OMDB server.

For OMDB, a com.opsware.reporting.util package was created to use with BIRT.
Reports are JDBC-based and include embedded SQL. In the data-set of the BIRT Reports
for the OMDB, set the beforeOpen script to:

importPackage (Packages.com.opsware.reporting.util)
request = reportContext.getHttpServletRequest () ;

var requestParamMap = new Packages.java.util.HashMap () ;
for (1 = 1 ; 1 < ${Number of Parameters + 1} ; i++)

{

requestParamMap.put ("PARAM" +
i, reportContext.getParameterValue ("PARAM" + 1i));
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requestParamMap.put ("PARAM" + i +
"CO",reportContext.getParameterValue ("PARAM" + i + "CO"));
requestParamMap.put ("PARAM" + i +
"DT", reportContext.getParameterValue ("PARAM" + i + "DT"));

}

queryText = SqlUtilities.processBeforeOpenEvent (queryText,
requestParamMap, request) ;

This will retrieve the SQL query for the report and pass it to a parser to replace any
runtime variables. Runtime variables for the OMDB reporter are denoted in the SQL as
ansi style C comments and have a begin and end tag. The begin tag is /*PARAM'n"*/ and
the end tag is /*/PARAM'n' */ where 'n' is greater than 0. In addition to the begin and
end tags, there is a operator position tag /*Cx* /.

In the above code the token $ {Number of Parameters} should be replaced with the
number of parameters that the report has + 1. For example, if the report has 4
parameters, replace the token ${Number of Parameters} with the number 5.

For example, the query below for a report with runtime value:

select full date

from cmdb data.date dimension

where 1 =1

/*PARAM1*/and full date /*C*/ = trunc(sysdate)/*/PARAM1*/

When the report is run, one of the following events occur:

« |f the user selects Any Value for the parameter, then the string between the begin and
end tags is removed.

If a value is picked with an operator (in, equal, not equal) then the string between the
operator position tag and end tag is replaced with the appropriate operator/parameter
value string.

If the parameter value is text and case-insensitive (by default), then the left-side
expression between AND or OR and the operator position tag will be enclosed by an
UPPER function. The parameter value will also be upper-case.
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Parameters in custom_def .xml for OMDB take a string of SQL for their lookup values.
This is different from the way reports are parameterized in SAS, with a resource type and
resource field.

Parameter Substitution of Dates

The OMDB reporting data source omdb-reporter-ds.xml used by the OMDB BIRT
engine is configured to set all session connections to the current user's time zone as
these connections are accessed by BIRT. This allows for the use of certain functionality
within Oracle to ensure that date processing occurs and is displayed relative to the user's
time zone.

The OMDB cMDB-DATA schema includes a DATE_DIMENSION view that is useful in
creating the date-based SQL typically used in OMDB's historical reporting. This view
contains a number of date-related columns for reporting including FULL_DATE _LOCAL
and FULL_DATE_UTC. All columns are relative to the user's local midnight boundary
(including FULL _DATE_LOCAL) except for FULL_DATE UTC. FULL DATE UTC is a
calculated value based on the offset of the user's time zone from FULL_DATE_LOCAL.
The time component of FULL DATE LOCAL is always midnight (00:00:00), so for
someone in New York (EST), FULL_DATE_UTC will be 5 hours later than FULL_DATE _
LOCAL meaning its time component will be 05:00:00.

When doing parameter substitution of single dates or date ranges, these values will be
substituted in the current user's time zone and should always be compared to

FULL _DATE LOCAL. When using the resulting DATE_DIMENSION records to access
historical data tables, the FULL_DATE_UTC column must be used as all OMDB data time
stamps are UTC.

The following two functions are available for performing time zone offsets:

+ UTC_TO_LOCAL: Use this to convert almost all OMDB time stamp columns to local
time for display in the user's local time zone

+ LOCAL_TO_UTC: This will convert a local time stamp to UTC, which may not be useful
for return to BIRT, but may be useful in other scenarios.

Almost all time stamp columns returned for display in BIRT should be wrapped in the
UTC_TO_LOCAL function for correct display. The only time you wouldn't do this is if there
is a need to display the date in UTC or if a BIRT expression is being used to convert the
UTC time stamp to some other desired value.
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You can substitute a single date, or the begin date or end date of a date range, into a
query rather than having to create a full AND or OR conditional statement. To do so, use
the following syntax:

/*PARAMNVAL*/ sysdate /*/PARAMnVAL*/
/*PARAMNBEGIN*/ sysdate /*/PARAMNBEGIN*/

/*PARAMNEND*/ sysdate /*PARAMNEND*/

Actionability

OMDB reports can also support actionable items. For example, a server entry in a report
can be set as actionable. Right-clicking on that server displays a pop-up menu of actions
available for that server.

Setting a Table as Actionable

To set a table as actionable, perform the following steps:

E Launch BIRT RCP Designer.

In the Outline pane, expand the report name, and then expand Body.

Select the table name.

In the Property Editor -table name, click the Properties tab.

In the Properties list, select Bookmark.

In the text field, enter the following string:
id="'"'actionable''

From the File menu, select Save.

Adding Source and Item IDs to a Custom Report

To add the source and item id to your custom report, perform the following steps:
E Launch BIRT RCP Designer.

Expand Data Set.

Double-click the data set that is associated with the report.

In the query text field, add an actionable text string. See for the acceptable formats
and values.
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In the left list of the Edit Data Set window, click Output Columns.
Click OK.

o o

Expand the Data Set.

Drag the new column into the table as the first column of the Detail Row of the table.

OMDB Actionable Item Formatting

The preferred format for OMDB actionable items is:
source type:item id

For example:

SAS SERVER:1001

where SAS is the source type and 1001 is the item id of the specific item. The item id is a
numeric value unigue to your OMDB installation. The supported data source values for
this syntax are:

asas_fibre fabric:
asas_storage_ device:
asas_fibre alias:
asas_fibre zone:
asas_fibre zone set:
asas_file system:
asas_port:

nas_device:
nas_user:
nas_usergroup:

sas_server:
sas_sw_policy:
sas_patch policy:
sas_app_config:
sas_job:
sas_user:
sas_usergroup:
sas_audit:
sas_audit result:
sas_customer:
sas_package:
sas_facility:
device:

software policy:
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patch policy:
configuration:
compliance test:
job:

user:
usergroup:
audit policy:
audit_ task:
audit result:
customer:
software unit:
facility:

device:

device group:
software policy:
patch policy:
configuration:
compliance test:
job:

user:

usergroup:

audit policy:
audit_ task:
audit result:
customer:
software unit:
facility:

An older and alternate supported format for OMDB actionable items is:
source:object type:id
The actionable source and object type pairs are limited to:

sas:device:
sas:patch policy:
sas:configuration:
sas:compliance test:
sas:configuration:
sas:compliance test:
sas:job:

sas:user:
sas:usergroup:
sas:audit_policy:
sas:audit_task:
sas:audit_result:

94 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.



Chapter 4: OMDB Custom Reports

Set the objectid to the object id in SAS or NAS. Do not set objectid toanitemidin
OMDB.
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